
Tutorial

Main Screen

The main screen is customisable, so you can display the windows you find
most useful. The current selection of windows are: Arrange, Mixer, SFile
Manager, Marker Directory, SDisk Directory, AVI Player, Big Current Time, Buffer
Activity, and the Main Window with the Toolbar across the top and the Tape
Transport across the bottom. Each window can be hidden or displayed in its
saved size and position with a single keystroke.

An arrangement can contain up to 8192 individual parts which use digital
audio takes stored on Soundscape’s hard disk(s). The arrangement can be
created, or an arrange file (.arr) can be loaded into the arrange window from
either the PC’s or Soundscape’s hard disk, edited, and then saved back to the
PC or SDisk. Up to 4096 takes of any length (limited by the disk size) can be
stored on each SDisk.

The arrange file and any associated takes can be backed up to DAT or to any
logical PC drive when the hard disk is full.

If you don’t backup... you risk losing your valuable work. We can’t help!
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Main Window and Toolbar

The Main Window contains the main menu headings and a Toolbar which is
used for most on-screen editing.

Tool Selection

Four tools can be selected on the mouse,
as shown. Tools are selected for the left
and right mouse buttons by clicking on a tool with the mouse button you wish
to assign. The active tool will have a black bar under the left or right side to
identify which mouse button is assigned. Holding the ALT key while selecting
the tool allows two additional tools to be selected, identified with a red bar
under the left or right side of the tool icon. The ALT key must also be pressed
when using the editing tools assigned in this way. Note that the tool will remain
selected even if a different tool page is selected which does not contain that
tool icon.

Note: If the same tool is selected for the left and the Alt+left mouse buttons, then only
the black bar will be shown.

Status Bar

The Status bar, displayed underneath the toolbar, provides information and
quick selection for some of the more commonly accessed parameters from
the Settings menu, as well as showing the current mouse position within the
arrangement. Currently selected values for Snap, Synchronisation, Sample
Rate and Tracks per Unit are displayed. The time between left and right
locators is also displayed in bars:beats:ticks or SMPTE + sample extension at
the current frame rate.

The Status bar can be turned on or off under the View menu.

Mouse Position

The Mouse position is continuously updated with the current position in the
arrangement. The Snap setting determines the resolution of the readout, and
the Time Axis setting (SMPTE or bars:beats:ticks) determines how the position is
displayed. In SMPTE mode the sample within each frame is also shown.
The number displayed on the far left indicates which ‘virtual’ track the mouse is
currently placed over. This is useful for keeping parts on the same track in
large arrangements. For example, you may want to keep all vocal takes on
track 17 so that you can use global edits to alter the volume or positioning
even if some of the vocals are assigned to different outputs.
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The mouse resolution across the display depends upon the screen resolution
(e.g. 800 or 1024 pixels), so don’t expect to be able to move in steps of 1
frame when you are displaying 1 minute of the arrangement on screen. If you
‘zoom in’ the mouse position readout will be as expected.

Bars:Beats:Ticks mode:-

SMPTE mode:-

Snap Value

Click on the Snap value readout and a menu of snap values
will drop down, for quick selection. When parts are moved or
copied, the outline of the selected parts that you are dragging
will jump to the snap points.

Sync

Clicking on Sync displays a list of synchronisation choices also found in the
Settings menu, i.e. Mtc Master, Slave or Trigger and MIDI Clock Master.

Sample Rate

Click on the Sample Rate readout to display the same selection
as in the Settings menu. When using the digital input, the
Sample Rate readout shows the frequency being received
(except when using TDIF Masterclock).

When the Varispeed is not set at 0.00%, the Sample Rate will be
displayed in Red in the Status Bar.

Customisable Toolbar “Page Up / Page Down” to scroll Toolbars

There are 9 customisable Toolbars which can be accessed from the keyboard
or by using the mouse. To customise a tool page, first select the tool page
you wish to change by clicking with left or right mouse buttons on the tool
page number, or using the page up/down keys. Next, double click on an
empty space in the tool page, or select ‘Customise Tool Page...’ in the
Settings menu.

This will pop up a window with all available tools displayed as shown overpage.
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Click on any tool icon to display a description of it’s function. Tool icons can
be dragged and dropped in position on the tool page and existing tools will
be shifted towards the right to make room for the new tool if necessary.

To delete a tool from the tool page, drag and drop the white trash can icon
over the one that you wish to remove. Tools will then be shifted to the left to
close up the space.

To insert a space between tools, drag and drop the full space or half space
icons (empty boxes beside the trash icon) at the required position.

Once you are happy with the tool page, click on Save before you select
Close. This will save all changes you have made to the current tool page in
the initialisation (.ini) file.
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Arrange Window “A”

The Arrange Window is where most of the work takes place. It shows the
on-screen layout of your arrangement, with up to 256 virtual tracks displayed
vertically down the screen and any number of parts across the screen making
up each track. The coloured parts are active and are assigned to one of the
8/12 output or physical tracks. All uncoloured tracks or parts are muted, as
they are not assigned to an output and so will not be heard when the
arrangement is played.

The current file name and storage disk for the arrangement are displayed
across the top of the arrange window in the caption bar.

Record Track Column

The Record Track Column allows you to setup virtual track position, record loop
stack size and track arming status for the track(s) to record onto.

Soundscape can record on up to 12 tracks through its analogue and digital
inputs or from any of the 16 busses in the mixer.

Note: When using the analogue inputs, set the -10dBV/+4dBV input level switch on
the rear panel of the rack unit for the type of levels you are using (only for the
unbalanced RCA/cinch inputs). Professional equipment normally uses a
+4dBV level, and semi-professional equipment may use -10dBV.
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To make a recording:-

1 Open an appropriate mixer for recording. e.g. mix1.mix

2 If using the punch in/out buttons, set the left and right locators for the length of
the part you want to record. Otherwise, just position the play locator where
you want to start recording.

To set the left locator, click the left mouse button on the time axis bar and the
right mouse button for the right locator. To set the play locator, click on a free
space in the arrange window. To set a timecode or measure punch point,
double click on any locator readout in the transport bar.
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3 Right click on a free space in the record track column. A “flyout menu” will
appear to select mono or stereo and which tracks to record onto.

4 Release the mouse on the track(s) you wish to record on. Make the tracks
“record ready” by clicking on the circles in the box to the right of the track
numbers.

Only record tracks that have corresponding track elements in the mixer get
track coloured, and are allowed to be armed for recording. Tracks can also
be armed from the mixer, if the corresponding record tracks exist in the record
track column.

Record Track Arming using the Keyboard

You can also arm or disarm individual or multiple record-tracks directly from
the keyboard by using the number keys with “*” to arm, “/” to disarm and “-”
to select a track range.

* key pressed arms all record-tracks that exist in the mixer & record-track.
* key preceeded by an entered number only arms that record-track (if it exists
in the mixer & record-track ), eg. 5* arms track 5.
* key preceeded by 2 entered numbers separated by - key, arms all
record-tracks from the first to the second number if they exist. eg. 3-8* arms all
existing record-tracks from track 3 to 8.

/ key pressed disarms all record-tracks that exist.
/ key preceeded by an entered number only disarms that record-track if it
exists. eg. 5/ disarms track 5.
/ key preceeded by 2 entered numbers separated by - key, disarms all
record-tracks from the first to the second number if they exist. eg. 3-8/ disarms
all existing record-tracks from track 3 to 8.

Note: It is not possible to make a mono track record ready if it is designated as a

stereo pair in the active mixer. i.e. If tracks 1+2 are assigned as a stereo pair in
a mixer channel, it is not possible to record only on track 1 or track 2.

$ It is not really important which tracks you use for recording, as you can easily
select different tracks for the parts later.

Note: If the recording fails (ie. if there is a power failure or PC crash, then the
recorded Takes will be saved (see Toubleshooting chapter).
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5 Repeat this procedure for any other tracks you wish to record. Dragging the
track numbers in the record column with the left mouse button allows for
moving the virtual track position of existing record tracks.

" Be very careful not to cause the input to clip while recording, as with all
digital systems, this can result in very high distortion levels, especially for
prolonged clipping.

If there is not enough contiguous (continuous) disk space to record a take of
the length defined by the locators, this warning box will be displayed.

If the range you have designated to record overlaps a part with the same
output assignment, the overlap area of the active part will be muted.

6 Click on the record button on the tape transport window or press the “+” key
on the keyboard to start recording.

7 If punch in/out buttons are pressed, Soundscape will drop into record mode at
the left locator and will drop out of record mode and stop at the right locator.
Otherwise, just press stop (down arrow key) to stop recording. The “record
status indicator” will change from black to red whilst in record (both in the
record column and the mixer). If you click on stop or press the “down arrow”
key before right locator is reached, the recorded parts will be truncated to the
play pointer position.

The default name of the recorded parts/takes is the same as the mixer
channel that contains the track element. You can change the part and take
names very easily later on if you wish. (See Info tool in Editing Tools chapter).
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Automated Punch-in Punch-out Recording Mode

The automated punch-in recording mode allows new material to be recorded
and inserted into existing parts in the arrangement. This is still non-destructive
but the part is automatically replaced in the arrangement (i.e. audio is not
overwritten on the disk).

To punch-in to an existing track, first position the locators. Assign the record
track and position the play pointer before the “in” point. Upon pressing record
cuts are made automatically in the existing part at the locator positions, even
if the new part to be recorded is on a different virtual track. However, in this
case, the existing part will be muted. If you decide not to keep the recording
select “Undo” from the Edit menu (or Ctrl+Z from the keyboard) then any edits
made will be ‘cleaned up’ so the arrangement is returned to the same state
as before recording.

The existing audio is not removed, so even if the punch-in and out points
(locator positions) were not defined accurately, the edit point can be adjusted
easily later.

In the example below, a vocal part had been recorded on track 1, but it was
necessary to re-record a section of it with a new vocal attempt. The locators
were dropped in the rough area where the punch-in was required.

Recording on the virtual
track below the existing
part made edits in the
original track and muted
the punch-in area.

After recording, the Trim
tool was used to more
accurately position the
punch-in and punch-out
points.
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Record Looping, Preroll and Stacked takes

The Record Setup dialogue box allows you to select a programmable
pre/postroll for loop recording.

When a Loop Stack is created, instead of stopping at the right locator,
Soundscape drops out of record mode and after a short delay (for
Soundscape to clear its record buffers) it will start recording again at the left
locator, overwriting the previous take. If you click on stop or press the “down
arrow key” during the looping delay, the last take recorded is safe.

If Preroll is active and a timing value is entered for the Preroll Length, then the
play pointer will play from a position set by the Preroll Length, before the left
locator. This gives you time to prepare for the next recording attempt.
Similarly, Postroll Length determines the time after dropping out of record at
the right locator that Soundscape continues to play before returning to the
Preroll position.

Selecting a value for Loop Stack allows recording of up to 9 takes per track,
stacked on different virtual tracks down the arrange window.

Note: The record loop stack in the record column will only be taken into account if the
loop button is pressed.

On each loop, the next virtual track is selected for recording, only overwriting a
take when the last take in the stack has been recorded and the first is selected
again (unless Autostop at end of recording loop stack is selected in Record
Setup). This is a similar feature to that provided by analogue multi-track tape
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machines, but with Soundscape there are 256 virtual tracks to use before you
need to erase a take.

Recording while Slaving to MIDI Timecode

In slave mode, Soundscape requires 2 seconds to chase lock to the incoming
timecode. For this reason, when recording, make sure that you start the
master device at least 2 seconds before the left locator position (punch-in),
otherwise Soundscape will not start. Alternatively, press Play and then when the
play locator starts moving, press the Record button.

To record at 00:00:00:00 (or Bar 1, Beat 1) means that the incoming MIDI
timecode must start at 23:59:58:00. It is easier to leave a short gap at the
start, or use a predefined SMPTE offset (e.g. 1 hour).

Note: Soundscape automatically defaults to the Analogue Inputs while in ‘Slave’
mode

Zoom In/Out

The Zoom In/Out buttons allow you to view the arrangement in more detail
horizontally or vertically each time you click with the mouse. When the vertical
and horizontal zoom levels are sufficient, the waveform for each part in the
arrange window is displayed automatically as shown:-
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The highest horizontal zoom level displays an individual sample for each pixel
across the screen. The time to read the waveform off the disk depends on how
many parts are displayed.

Horizontal zooming in the arrange window keeps the position of the play
locator in the same place on screen.

Vertical zooming is achieved by using the right mouse button on the zoom
button. This allows you to edit very quiet sections without changing the levels.

Zoom Box “Z” and “Shift Z”

Click once on the Zoom Box button to allow a selection
box to be drawn in the arrange window (by holding
down the left mouse button and dragging with the
mouse). The arrange window will then show the
selected area in more detail, with a waveform display if
both horizontal and vertical zoom levels are sufficient.

Double click on the zoom box button to return to the previous display shown in
the arrange window. Soundscape remembers the last 8 zoom levels, so that
you can return to any of the zoom levels you have just been through. Double
clicking on the zoom box will eventually return you to the default zoom setting.

Time Axis Bar

The Time Axis Bar across the top of the arrange window can display the
position in the arrangement either in bars, beats and ticks, or in SMPTE time, as
hours, minutes, seconds and frames.

If you are working with a MIDI sequencer or with a musical measure, you will
probably want to display bars and beats. The actual relationship between real
time (which is really what digital recorders work in) and the time axis, is given by
the combination of tempo, time signature and sample rate settings.
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A SMPTE time axis display is more applicable when working with video,
synchronising to external tape machines, or with material not based on a
particular musical measure, such as speech or radio programmes.

The musical measures can be set for triplet mode (1/4T, 1/8T, 1/16T, 1/32T),
and 0.5 sec, 1/10 frame and 1/100 frame are also included.

Parts

Each part in the arrange window plays a digital audio take (stored on the
SDisk) or any section of a take. Each part has individual start and end volume
settings, and the start point in the take and the length can be set to sample
accuracy. A take can be used any number of times by any number of
different parts without using more SDisk space, as Soundscape makes full use
of the random access capability of hard disks. Parts can be copied, moved,
cut, glued together, merged, gated, processed or deleted without changing
the original digital audio takes stored on disk.

Selecting Multiple Parts

Multiple parts can be selected by pointing at an empty section of the arrange
window (not on a part), clicking and holding the left or right mouse button and
dragging the mouse so that a select box is drawn. Any part which is touched
by the select box will be selected and will turn grey when the button is
released. The window scrolls if you drag the box to any edge. With the Shift
(Shft) key held, a box can be drawn when there is no empty space, so you
can start the box on a part on screen.

With the exception of the merge tool, all other tools can be used to perform
the same operation for multiple parts. This means for instance, that you can
copy or move a group of parts, make a cut across several parts in the same
position, set the volume for groups of parts (e.g. a complete track) or delete
several parts at once.

You can also select or deselect multiple parts by holding the Control (Ctrl) key
down on the keyboard while clicking on individual parts, so that you can add
parts to a group from anywhere in the arrangement.

Left and Right Locators

The Left and Right Locators are used to define the region for recording a take
and record looping, or for mixing several parts to form a mixed take. The time
between the locators is displayed on the status bar in the current display
mode. This is very useful for calculating timings for the time stretch option.

Setting the Locators “L” and “R”

To set the position of a locator, point at the required position in the time axis
bar and click with the left button (for the left locator) or right button (for the right
locator) on the mouse. The new locator position will take account of any snap
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setting you have selected (see the Settings menu section for information on
selecting the snap value).

“On the fly” positioning of the locators is possible by using the L and R keys
(while in play mode). They can also be dragged along the time axis using the
mouse buttons, and the mouse position readout can be used for accurate
positioning.

Alternatively, you can double click on the locator readout in the tape transport
window, and edit or select the timing position in the dialogue box. You can
enter spaces instead of colons (:) and leading zeros are not required. The
timing readout will be in bars, beats and ticks or in SMPTE timecode format
depending upon the time axis setting.

$ Clicking once on either locator readout in the tape transport window will move
the play pointer directly to either locator position.

Play Pointer

The Play Pointer shows the current play position in the arrangement. The tape
transport window has a readout in both bars/beats/ticks (Song Position) and
SMPTE time formats.

The pointer can be positioned in several ways:-

1 By clicking and holding on the Fast Forward or Rewind buttons or by pressing
the left or right arrow keys on the keyboard once, to move the play pointer
left or right quickly.

2 By clicking with the left mouse button on any empty section of the arrange
window, to move the play pointer to the mouse position (except between
the locators when the record or merge tools are selected).

3 By clicking on the left or right locator readouts, to move the play pointer to
the current locator position.

4 By clicking on the stop button or pressing the down arrow key on the
keyboard. If in play mode, the first button operation or key press will stop
Soundscape playing, then all subsequent operations will toggle the play
pointer between the left locator position and the start (bar 1, beat 1).

5 By clicking on the play button or pressing the up arrow key on the keyboard
once, to start playing from the current play position.
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6 By double clicking on the Song Position or SMPTE Time readout in the tape
transport window and entering or editing the value in the dialogue box, as for
locators.

$ Pressing the “C” key on your keyboard moves the current position of the play
locator to the centre of the arrange window and redraws the display. This
works at any time even during playback.

Tape Transport

The Tape Transport Window has all the normal controls that you would expect.
The button functions are, from left to right: To Beginning, To End, Rewind, Fast
Forward, Stop, Play and Record.

Rewind and Fast Forward Buttons “Left and Right Arrows”

The rewind and fast forward buttons are only active while pressing on them
with the left mouse button. The left and right arrow buttons on your keyboard
also function as rewind and fast forward. There is an option for ‘Fast Rew/FF‘ in
the sub menu called Preferences under the Settings menu.

Stop Button “Down Arrow”

If Soundscape is playing, click once on the stop button with the left mouse
button to stop at the current play position. Once stopped, all subsequent
operations of the stop button will toggle the play pointer between the left
locator position and the start (bar 1, beat 1).

Play Button “Up Arrow”

Click with the left mouse button on the play button to start playing from the
current play pointer position and the pointer will move across the arrange
window from left to right. When the end of the window is reached, the
arrangement scrolls to the left and the pointer starts again at the left hand
side.

$ Most editing functions can be used when playing or recording.

Record Button “Add”

Clicking on the record button with the left mouse button also activates the
play button. The play pointer will then either start playing from the current
position, or if the current position is ahead of the left locator, the play pointer
will jump back to the left locator. When the play pointer is at the left locator
position, Soundscape will drop into record mode, record the take(s) and when
the right locator position is reached, will automatically drop out of record
mode and stop.
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Using the Keyboard to Control the Tape Transport

The left, right, down and up arrow keys, and the + key perform the rewind, fast
forward, stop, play and record functions from the keyboard. The only
difference to using the mouse is that pressing the left or right arrow key once,
activates rewind or fast forward continuously, without you having to hold the
key down. To release the rewind or fast forward buttons, press the ‘up arrow’
key to start playing, or the ‘down arrow’ key to stop.

Tempo and Time Signature

The Tempo and Time Signature (SIGN) readouts can be set by
double clicking with the left mouse button to bring up a
dialogue box for either function. When setting the time
signature, be sure to enter the / key. The tempo can be set to
an accuracy of two decimal places e.g. 170.86 BPM

The tempo and time signature for Soundscape do not perform the same
function as for a MIDI sequencer, as the digital audio cannot be altered in the
same way as a MIDI sequence, where a passage can speed up or slow down
by using a different tempo. In Soundscape, they are used to determine the
time axis display and the snap ‘grid’, which is used when moving parts in the
arrange window to bar, beat or 1/16th timings etc.

MIDI Clock and Song Position Pointer generation also depends on the tempo
and time signature for calculation of the timing.

Timing Resolution

The resolution is 192 ticks to the beat in bars/beats/ticks mode, and down to a
100th of a frame accuracy for SMPTE time mode.

However, several parameters may require sample accuracy, for example,
when defining the length or position of a part in the arrangement, or where an
edit is made. These parameters will be displayed in SMPTE time, but with a
sample extension which defines the sample position within each frame.

The complete format is:- hours:minutes:seconds:frames:samples

The actual number of samples within each frame depends upon the sample
rate and SMPTE frame rate selected.

The table shown below gives the number of samples in each frame for each
of the standard sample rate and SMPTE frame rate settings. Where the value
given is not a full number of samples per frame, the number will be averaged
over a number of frames, so that there will always be a full number of actual
samples each frame.
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Number of Samples Per Frame

Sample
Rate

24fps 25fps 29.97fps 29.97df 30fps 30df

22.05kHZ 918.75 882 735.74 735.74 735 735

32.00kHZ 1333.33 1280 1067.74 1067.74 1066.66 1066.66

44056kHz 1835.66 1762.24 1470 1470 1468.53 1468.53

44.10kHz 1837.5 1764 1471.47 1471.47 1470 1470

47952kHz 1998 1918.08 1600 1600 1598.4 1598.4

48kHZ 2000 1920 1601.6 1601.6 1600 1600

Markers

The Marker Bar runs under the time axis in the arrange window and can be
turned on or off under the View menu.

You can have up to 999 named markers per arrangement, and these are
saved in the arrange file.

Marker Directory “W”

The Marker Directory window can be turned on under the View menu or by
pressing the W key. This shows a text listing of markers, their names and
locations in SMPTE or Bars, counts and ticks.

Inserting Markers

Markers can be inserted ‘on the fly’ at the current play position by pressing the
Insert key. Each time a marker is inserted, the marker ID number is
automatically incremented, but at any time you can type an ID from 1 to 999
before pressing insert, to place markers starting at a new ID. This makes it easy
to identify different sections of an arrangement with the markers (e.g. 100-199,
200-299 etc.).
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$ It is possible to edit a marker name while in record and playback modes.
Therefore, as soon as you drop markers, names can be added for easy
identification.

Moving Markers

To move an existing marker to the current play position, enter the marker ID
and press the Enter key. Pressing Enter again will then move the next marker
in turn to the current play position and this can continue until the last marker is
moved.

You can use the mouse to drag a marker to a new position by clicking with the
left button just to the right of the marker to select it. The snap setting will also
determine available marker positions when dragging with the mouse.

In the Marker Directory, double click on the marker entry with the left mouse
button to pop up a ‘Marker Info’ dialogue box where you can edit the marker
location in SMPTE or bars, beats and ticks format.

Moving L & R Locators to Marker Locations

To move the L or R locator to a marker location, type in the marker ID, then
press the L or R key. This can be performed while playing the arrangement.

Moving the Play Pointer to Marker Locations

To move the play pointer to a marker location, type in the marker ID, then
press the down arrow key or click on the stop button in the transport window.
This can be performed while playing the arrangement.

Click with the right mouse button to the right of a marker in the Marker Bar to
move the play pointer to the marker location.

In the Marker Directory, click on the marker entry with the right mouse button
to move the play pointer directly to the marker location.

Playing from a Marker Location

To start playing from a marker location, type in the marker ID and press the Up
Arrow key or click on the play button in the Transport window.

Naming a Marker

In the Marker Directory, double click on the marker entry with the left mouse
button to pop up a ‘Marker Info’ dialogue box.
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You can enter a marker name up to 30 characters in length.

Deleting Markers in the Marker Directory

To delete a marker from the Marker Directory, click on an entry with either
mouse button to select it, then press the Delete key. Multiple deletes may be
made with one key press using the Ctrl and Shift keys, as described earlier for
‘Deleting takes in the SFile Manager’.

Buffer Activity Window “B”

The Buffer Activity window is displayed by pressing the
B key on the PC keyboard or by selecting it from the
View menu.

The buffer activity window provides an indication of how much digital audio
data is in Soundscape’s internal buffer memory at any instant. The buffer is
continuously refilled, as data is read in bursts from the hard drive for each
track. The digital audio is then played out directly from the buffer at the
selected sample rate.

The figure displayed shows the lowest percentage of data in the buffers that
has been detected for all audio tracks, and the bar display is the current
minimum level. Pressing the reset button clears the minimum level and
restarts at 100%.

" For Soundscape to maintain correct audio timing for all tracks, it is
important that the amount of data in the buffer memory never falls to zero,
and it is the DSP’s task to try to ensure that this does not occur.

However, functions such as the real-time fades require some of the available
DSP processing power, and there are several other factors that can influence
the ability of the DSP to keep the buffers filled. The most important of these
are:-

number of real-time fades active at the same time
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the sample rate selected

number of active tracks being played

position of the audio takes on the drive

speed of the hard drive (access time, data rate)

size and number of parts in the arrangement

With a slow (e.g. 18mS) hard drive, the minimum buffer level detected will
obviously be less than for a faster drive.

If the level of fragmentation becomes high enough so that one of the track
buffers is not refilled quickly enough, the following warning box will be
displayed:-

This may seem quite serious at first, but in fact there are several very easy ways
to remedy the situation.

Reduce the amount of work that the disk head is asked to
perform, by mixing down some of your edits on one track to
form a new take. (see Mixdown Tool in the Editing Tools chapter))

Reduce the number of real-time fades by merging to a new
take which includes the fade.

Use a lower sample rate (e.g. 44.1kHz instead of 48kHz).

Buy a faster hard drive (10mS - 13mS is now the standard speed even for
low cost drives).

The last option is obviously not the best, but if you are considering buying a
second (probably bigger) drive mechanism for Soundscape, you should buy
the fastest one that you can obtain as this will also be an advantage with
some of the planned new features. Most higher capacity hard drives are
inherently faster than the smaller drives which generally use older technology.
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